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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©June 2010

Trademarks
Intel and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
III



Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.

If your purchase option includes both Wireless LAN and 3.75G modules, then the appropriate antennas will be installed.
Note that In order to comply with FCC RF exposure compliance requirements, the antenna must not be co-located or operate
in conjunction with any other antenna or transmitter.

Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module and the Bluetooth/Wireless LAN
modules at the same time as this may disrupt radio frequency, and cause interference. When the 3.75G/HSPA module is
powered on, make sure that the Bluetooth/Wireless LAN modules are powered off.
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Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit with an AC Input of 100 - 240V, 50 - 60Hz, DC 

Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.

CAUTION
Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, 
TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class 1 Product
V



Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
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3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VII
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Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a steady, 

uninterrupted power supply. If you are unsure of your local power specifications, consult 
your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong 
is an important safety feature; do not defeat its purpose. If you do not have access to a 
compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not by 
its wire.

• Make sure the socket and any extension cord(s) you use can support the total current load 
of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power sup-
plies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines). It is
advisable to also re-
move your battery in
order to prevent acci-
dentally turning the
machine on.
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Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before turning the computer on.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hard-

ware and software. Make sure your documents are prepared.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
XII
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the 
level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on 
a footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles 

when you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent 

and short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.
XIV
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, card reader, ExpressCard/34), Touchpad & Mouse, Audio & Printer.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 Instructions for upgrading your computer.
• Chapter 7 A quick guide to the computer’s PC Camera, Wireless LAN, 3.75G/HSPA, Bluetooth, and Fin-

gerprint modules (some of which may be optional depending on your purchase configuration).
• Chapter 8 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on the Video driver controls.
• Appendix C The computer’s specification.
Overview 1 - 1
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Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 7) and applications (e.g. word processing, spreadsheet and database programs)
have their own manuals, so please consult the appropriate manuals.



Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an 

outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 120 degrees); use the other 

hand (as illustrated in Figure 1 - 1 below) to support the base of the computer (Note: Never lift the computer by 
the lid/LCD).

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In


Shutdown

Note that you should always shut your computer down by choosing the Shut Down command from the bottom right of the
Start menu in Windows. This will help prevent hard disk or system problems.
1 - 4 System Startup
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find that this manual refers to the Windows 7
operating system.


Windows OS

In order to run Windows 7 without limitations or decreased performance, your computer requires a minimum 1GB of sys-
tem memory (RAM), however if you are running Windows 7 64 bit your computer requires a minimum 2GB of system
memory (RAM).
System Startup 1 - 5
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Model Differences
This notebook series includes two different model types that mainly differ as indicated in the table below. Note that
your model may appear slightly different from those pictured in this manual.

Table 1 - 1 - Model Differences

Feature Model A Model B

Display Type 
Supported

15.6” (39.62cm) HD (1366 * 768) / HD+ (1600 * 900) / 
FHD (1920 * 1080) 16:9 LCD Panel

17.3” (43.94cm) HD+ (1600 * 900) / FHD (1920 * 1080) 16:9 
LCD Panel

MOFA LCD Back 
Cover

Factory Option N/A

3.75G Module
UMTS/HSPDA-based 3.75G Module 

with USB Mini-Card Interface 
(Factory Option)

N/A

Modem 56K Fax Modem N/A

Fingerprint 
Module

Factory Option N/A

Dimensions & 
Weight

374mm(w) * 250mm(d) * 25-37.2mm(h)
2.6 kg with ODD & 48.84WH Battery

413mm(w) * 277mm(d) * 25.1-38.9mm(h)
3.1 kg with ODD & 48.84WH Battery
1 - 6 Model Differences
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System Map: LCD Panel Open - Model A Figure 1 - 2
LCD Panel Open - 

Model A

1. Built-In PC Camera 
(Optional)

2. LCD
3. Power Button
4. GPU Button
5. LED Indicators
6. Hot Key Buttons
7. Keyboard
8. Built-In Microphone
9. Touchpad & 

Buttons
10. Fingerprint Reader

9

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

10

2

4

1

7

9

3
5


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the 3.75G/
HSPA/WLAN/Bluetooth
modules, and check the LED
indicator or on-screen icon to
see if the modules are pow-
ered on or not (see Table 1 -
5, on page 1 - 12/ Table 1 -
3, on page 1 - 9).

6

4
5

8

10
System Map: LCD Panel Open - Model A 1 - 7
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System Map: LCD Panel Open - Model BFigure 1 - 3
LCD Panel Open

Model B

1. Built-In PC Camera 
(Optional)

2. LCD
3. Power Button
4. GPU Button
5. LED Indicators
6. Hot Key Buttons
7. Keyboard
8. Built-In Microphone
9. Touchpad & 

Buttons

Note that the Touchpad and
Buttons valid operational area
is that indicated within the red
dotted lines above.

9

2

4

1

7

9

3
5


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the mod-
ule(s) are OFF if you are
using the computer aboard
aircraft.

Use the key combinations to
toggle power to the WLAN/
Bluetooth modules, and
check the LED indicator or
on-screen icon to see if the
modules are powered on or
not (see Table 1 - 5, on
page 1 - 12/ Table 1 - 3, on
page 1 - 9).

6

8

4
5

3
6

1 - 8 System Map: LCD Panel Open - Model B
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LED Indicators
The LED indicators on the computer display helpful
information about the current status of the computer.

Table 1 - 2 - Front Left LED Indicators

Table 1 - 3 - Top Case LED Indicators

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green
The Computer is in Sleep 

Mode

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange
The Battery Has Reached 
Critically Low Power Status

Green Number Lock Activated

Green Caps Lock Activated

Green
Scroll Lock Activated (to 

activate press Fn & Scr Lk)

Icon Color Description

Green UMA Mode Activated

Orange  Optimus Mode Activated

Green Intel Integrated GPU (iGPU) Activated

Orange NVIDIA Discrete GPU (dGPU) Activated

White
The (optional) Bluetooth Module is 

Powered On

White Hard Disk Activity

White The Computer is Powered On
LED Indicators 1 - 9
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Hot Key Buttons & Keyboard
Press the hot key buttons on the computer to toggle the appropriate function on/off.

Table 1 - 4 - Hot Key Buttons

Icon Color Description

Green UMA Mode Activated

Orange  Optimus Mode Activated

The (optional) Wireless LAN Module is Powered On

Volume Mute is Enabled

The (optional) PC Camera is Powered On

White The Computer is Powered On


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 10 Hot Key Buttons & Keyboard
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and features function keys to al-
low you to change operational features instantly. See Table 1 - 5, on page 1 - 12 for full function key combina-
tion details.

Figure 1 - 4 - Keyboard

Numerical Keypad 

Play/Pause Key

Function Keys NumLk & 
ScrLk Keys

Fn Key
Keyboard 1 - 11
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Table 1 - 5 - Function & Hot Key Indicators

*Make sure that Wireless is ON in the Windows Mobility Center to ensure proper wireless function key behavior (see “Wireless Hot
Keys” on page 3 - 12).

Keys Function Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F5/F6 Volume Decrease/Increase 

Fn + 3.75G Module Power Toggle* Fn + F7 Display Toggle

Fn + F1 Touchpad Toggle Fn + F8/F9 Brightness Decrease/Increase 

Fn + F2
Turn LCD Backlight Off

(Press a key to or use Touchpad to turn on)
Fn + F10 PC Camera Power Toggle 

Fn + F3 Mute Toggle Fn + F11 *WLAN Module Power Toggle 

Fn + F4 Sleep Toggle Fn + F12 Bluetooth Module Power Toggle 
1 - 12 Function/Hot Key Indicators
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System Map: Front & Left Views
Figure 1 - 5

Front & Left Views

1. LED Indicators (see 
Table 1 - 2, on 
page 1 - 9)

2. External Monitor 
Port

3. RJ-45 LAN Jack
4. HDMI-Out Port
5. 2 * USB 2.0 Ports
6. e-SATA Port
7. Vent/Fan Intake
8. 1 * USB 3.0 Port or 

USB 2.0 Port 
(Factory Option)

9. 9-in-1 Card Reader

2
7

4

1

6
3



9-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible

MS (Memory Stick) / MS Pro / MS Duo

USB 3.0 Port OR USB 2.0 Port

Some models in this series have a single USB 3.0 port (Factory Option) on the left side
of the computer, other models will have a USB 2.0 port. The USB 3.0 port is denoted by
its blue color; USB 2.0 ports are colored black.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7) and
does not support wake on USB.

95 5 8
System Map: Front & Left Views 1 - 13
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System Map: Right & Rear ViewsFigure 1 - 6
Right & Rear Views

1. Headphone-Out 
Jack

2. Microphone-In 
Jack

3. S/PDIF-Out Jack
4. USB 2.0 Port
5. RJ-11 Modem 

Jack (Optional for 
Model A Only)

6. Optical Device 
Drive Bay

7. Security Lock Slot
8. Battery
9. DC-In Jack

1
5

2
6

3 4

1 2
6

3 4

Model A

Model B

7 8 9
1 - 14 System Map: Right & Rear Views
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
Disk Eject Warning

Don’t try to eject a CD/DVD while the system is ac-
cessing it. This may cause the system to “crash”. Stop
the disk first then eject it, or press the stop button
twice.

CD/DVD Emergency Eject

If you need to manually eject a CD/DVD (e.g. due to
an unexpected power interruption) you may push the
end of a straightened paper clip into the emergency
eject hole. Do not use a sharpened pencil or any ob-
ject that may break and become lodged in the hole.
Don’t try to remove a floppy disk/CD/DVD while the
system is accessing it. This may cause the system to
“crash”.


Changing DVD Regional Codes

Go to the Control Panel and double-click Device
Manager (Hardware and Sound), then click the +
next to DVD/CD-ROM drives. Double-click on the
DVD-ROM device to bring up the Properties dialog
box, and select the DVD Region (tab) to bring up the
control panel to allow you to adjust the regional code
(see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-
dependent. You can select your module’s region
code 5 times. The fifth selection is permanent. This
cannot be altered even if you change your operating
system or you use the module in another computer.
System Map: Right & Rear Views 1 - 15
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System Map: Bottom View - Model A 
Figure 1 - 7

Bottom View 
Model 

1. Battery
2. Component Bay 

Cover
3. Fan Intake
4. Hard Disk Bay 

Cover
5. Speakers

2

3

1

4

3


Battery Information

Always completely dis-
charge, then fully charge,
a new battery before using
it. Completely discharge
and charge the battery at
least once every 30 days
or after about 20 partial
discharges. See “Battery
Information” on page 3 -
11 for full instructions.


CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

3

55
3

3

1 - 16 System Map: Bottom View - Model A
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System Map: Bottom View - Model B 
Figure 1 - 8

Bottom View
Model B

1. Battery
2. Component Bay 

Cover
3. Fan Intake
4. Hard Disk Bay 

Cover
5. Speakers

2

1

4

3


CPU

The CPU is not a user serviceable part.

Overheating

To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake
while the computer is in use.

3

55

3

3


Battery Information

Always completely dis-
charge, then fully charge,
a new battery before using
it. Completely discharge
and charge the battery at
least once every 30 days
or after about 20 partial
discharges. See “Battery
Information” on page 3 -
11 for full instructions.
System Map: Bottom View - Model B 1 - 17
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3.75G/HSPA Module USIM Card Installation
If you have included an optional 3.75G/HSPA module in your purchase option (Factory Option for Model A
Computers Only), follow the instructions below to install the USIM card (which will be provided by your ser-
vice provider), and then run the Mobile Partner application. See “Mobile Partner” on page 7 - 24 for instruc-
tions on installing the program etc. 

1. Turn off the computer, and turn it over and then remove the battery (slide the latches in the direction indicated 
below and slide the battery out).

2. Insert the USIM card (at the rear of the battery compartment) as illustrated below until it clicks fully into position, 
and replace the battery.

Figure 1 - 9 - Battery Removal & USIM Card Insertion


USIM Card 
Orientation

Note that the USIM
card’s readable side
(with the gold-colored
contacts) should face
upwards as illustrated.
1 - 18 3.75G/HSPA Module USIM Card Installation
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Windows 7 Start Menu & Control Panel
Most of the control panels, utilities and programs within Windows 7 (and most other Windows versions) are ac-
cessed from the Start menu. When you install programs and utilities they will be installed on your hard disk
drive, and a shortcut will usually be placed in the Start menu and/or the desktop. Right-click the Start menu
icon , and then select Properties if you want to customize the appearance of the Start menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features
in Windows (e.g. power, video, network, audio etc.). Windows 7 provides basic controls for many of the features,
however many new controls are added (or existing ones are enhanced) when you install the drivers. To see all
controls it may be necessary to toggle off Category View to view the control panel icons.

Figure 1 - 10 - Start Menu & Control Panel

Click here to toggle Category View

 

3.75G/HSPA Module USIM Card Installation 1 - 19
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Video Features
NVIDIA® Optimus™ Technology
NVIDIA® Optimus™ technology is a seamless technology designed to get best performance from the graphics
system while allowing longer battery life, without having to manually change settings. When the computer is in
Optimus Mode it will automatically switch between the integrated UMA (Unified Memory Architecture) GPU
(iGPU) and the discrete GPU (dGPU) when required by the applications in use. This switch is seemless to the
user and does not require any use of the GPU button (see “NVIDIA® Optimus™ Technology” on page B - 3).

The GPU button  allows you to switch between the Optimus Mode (where GPU switching is automatically
handled) and UMA Mode (for constant power-saving with the integrated GPU only). 

Table 1 - 6 - GPU Modes & GPU LED Indicators

You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows 7 (see over). For more detailed video information see “Video Driver Con-
trols” on page B - 1. 

Icon Color Description Note

Green UMA Mode Activated

The GPU LED indicators  will 
display which GPU is currently in use.

Orange  Optimus Mode Activated

Green Integrated GPU (iGPU) Activated

Orange Discrete GPU (dGPU) Activated
1 - 20 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows:

1. Click Start and click Control Panel.
2. Click Display (icon) - In the Appearances and Personalization category.
3. Click Adjust Screen Resolution/Adjust resolution.
4. Alternatively you can right-click the desktop and select Screen resolution.
5. Use the dropbox to select the screen Resolution  (Figure 1 - 11).
6. Click Advanced settings  (Figure 1 - 11) to bring up the Advanced properties tabs.

Figure 1 - 11 - Screen Resolution

1
2

1

2

Video Features 1 - 21



Quick Start Guide1

To access the Intel(R) Graphics and Media Control Panel:
1. Click Advanced settings  (Figure 1 - 11 on page 1 - 21) in the Display Settings control panel in Windows.
2. Click Graphics Properties (button)  (Figure 1 - 12) in the Intel Graphics & Media Control Panel tab.
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon   (Figure 1 - 12) in the taskbar and select Graphics Properties from the menu.
OR
5. Access the Intel(R) Graphics and Media Control Panel from the Windows control panel in Classic View.

Figure 1 - 12 - Intel Graphics and Media Control Panel

2
3

4

3 4
1 - 22 Video Features
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To access the NVIDIA Control Panel:
1. Right-click the desktop and select NVIDIA Control Panel  (Figure 1 - 13).
OR
2. Click the icon   (Figure 1 - 13) in the taskbar and select Open the NVIDIA Control Panel from the menu.

Figure 1 - 13 - NVIDIA Control Panel

5

6

5

6

Video Features 1 - 23
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Power Options
The Power Options (Hardware and Sound menu) control panel icon in Windows (see page 1 - 17) allows you
to configure power management features for your computer. You can conserve power by means of power plans
and configure the options for the power button, sleep button, computer lid (when closed), display and sleep
mode from the left menu. Note that the Power saver plan may have an affect on computer performance.

Click to select one of the existing plans, or click Create a power plan in the left menu and select the options to
create a new plan. Click Change plan settings and click Change advanced power settings to access further con-
figuration options.

Pay attention to the instructions on battery care in “Battery Information” on page 3 - 11.

Figure 1 - 14 - Power Options
1 - 24 Power Options
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MOFA LCD Back Covers - Model A
MOFA (Magic of Film Art) technology allows fashionable and unique pictorial designs to be printed on the spe-
cially designed changeable LCD back covers. If your purchase option includes the specially designed change-
able LCD back cover option (Model A Computers Only), then follow the instructions in “Changing the
Optional LCD Back Covers” on page 6 - 12 to change the covers (note these covers are not applicable to all
models in this series - consult your service center for details).

Figure 1 - 15 - Magic Of Film Art Optional LCD Back Covers
MOFA LCD Back Covers - Model A 1 - 25
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Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Optical (CD/DVD) Device
• 9-in-1 Card Reader
• Touchpad and Buttons/Mouse
• Audio Features
• Optimizing Audio Recording
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height
of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For fur-
ther details see “Upgrading the Hard Disk Drive” on page 6 - 4.


Power Safety

Before attempting to ac-
cess any of the internal
components of your
computer please ensure
that the machine is not
connected to the AC
power, and that the ma-
chine is turned off. Also
ensure that all peripher-
al cables, including
phone lines, are discon-
nected from the comput-
er.

Figure 2 - 1
Hard Disk Location

HDD Bay HDD Bay

Model A Model B
2 - 2 Hard Disk Drive
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Optical (CD/DVD) Device
There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual de-
vice will depend on the module you purchased (see “Storage” on page C - 3). The
optical device is usually labeled “Drive D:” and may be used as a boot device if
properly set in the BIOS (see “Boot Menu” on page 5 - 13).

Loading Discs
To insert a CD/DVD, press the open button  and carefully place a CD/DVD onto
the disc tray with label-side facing up (use just enough force for the disc to click onto
the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you
are ready to start. The busy indicator  will light up while data is being accessed,
or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupt-
ed, insert an object such as a straightened paper clip into the emergency eject hole

 to open the tray.


Sound Volume 

Adjustment

How high the sound vol-
ume can be set depends
on the setting of the vol-
ume control within Win-
dows. Click the Volume
icon on the taskbar to
check the setting (see
“Audio Features” on
page 2 - 11).

 Figure 2 - 2
Optical Device

1

2

3

12 3
Optical (CD/DVD) Device 2 - 3
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Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please
follow the advice below to make sure that the data stored on your CDs/DVDs can be
accessed.

Note the following:

• Hold the CD or DVD by the edges; do not touch the surface of the disc.
• Use a clean, soft, dry cloth to remove dust or fingerprints.
• Do not write on the surface with a pen.
• Do not attach paper or other materials to the surface of the disc.
• Do not store or place the CD or DVD in high-temperature areas.
• Do not use benzene, thinner, or other cleaners to clean the CD or DVD.
• Do not bend the CD or DVD.
• Do not drop or subject the CD or DVD to shock.


CD Emergency Eject

If you need to manually
eject a CD (e.g. due to
an unexpected power
interruption) you may
push the end of a
straightened paper clip
into the emergency eject
hole. However please
do NOT use a sharp-
ened pencil or similar
object that may break
and become lodged in
the hole.

Disk Eject Warning

Don’t try to remove a
CD/DVD while the sys-
tem is accessing it. This
may cause the system
to “crash”.
2 - 4 Optical (CD/DVD) Device
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DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on
page 1 - 15.
.

DVD Regional Coding

Region Geographical Location

1 USA, Canada

2 Western Europe, Japan, South 
Africa, Middle East & Egypt

3
South-East Asia, Taiwan, South 

Korea, The Philippines, Indonesia, 
Hong Kong

4
South & Central America, Mexico, 

Australia, New Zealand

5 N Korea, Russia, Eastern Europe, 
India & Most of Africa

6 China

Table 2 - 1
DVD Regional Coding
Optical (CD/DVD) Device 2 - 5
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 9-in-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“CardReader” on page 4 - 7.

Note: Some of these cards require PC adapters that are usually supplied with the
cards.


Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 3
Left View

1. Card Reader

• MMC (MultiMedia Card) / RS MMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC Compatible
• MS (Memory Stick) / MS Pro / MS Duo

1

2 - 6 9-in-1 Card Reader
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Touchpad and Buttons/Mouse
The Touchpad is an alternative to the mouse; however, you can also add a mouse to
your computer through one of the USB ports. The Touchpad buttons function in
much the same way as a two-button mouse. 

Once you have installed the Touchpad driver (see “Touchpad” on page 4 - 7) you
can configure the functions by double-clicking the Touchpad driver icon  on the
taskbar. You may then configure the Touchpad tapping, buttons, scrolling (see
sidebar), pointer motion and sensitivity options to your preferences.


Touchpad Scrolling

This computer model se-
ries may feature different
Touchpad versions.

These Touchpads may
differ in their vertical
scrolling function in most
scrollable windows.

Some Touchpads require
sliding the finger up and
down on the right of the
Touchpad to scroll the
window. Other versions
require tapping/holding
down the finger at the top
right or bottom right of the
Touchpad to scroll the
window.

 Figure 2 - 4
Mouse Properties
Touchpad and Buttons/Mouse 2 - 7
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad to perform specific actions to manipulate doc-
uments, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 5
Mouse Properties - 

Device Settings
2 - 8 Touchpad and Buttons/Mouse
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the
Touchpad surface and slide both fingers in the direction required (in a straight con-
tinuous motion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the Touchpad (for best results use the tips of the fingers) and
slide them apart to zoom in, or closer together to zoom out.

 Figure 2 - 6
Scrolling Gesture


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 7
Zooming Gesture
Touchpad and Buttons/Mouse 2 - 9
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the Touchpad and slide it in a circular motion around the
stationary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 8
Rotating Gesture

 Figure 2 - 9
Flick/Press 

Gesture
2 - 10 Touchpad and Buttons/Mouse
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Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, or from the Realtek HD Audio Manager  icon in the taskbar/
control panel (right-click the taskbar icon  to bring up an audio menu). The volume
may also be adjusted by means of the Fn + F5/F6 key combination. 


Sound Volume 

Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 10
Realtek Audio 

Manager

Right-click the icon 
to access the menu 
above.
Audio Features 2 - 11
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Optimizing Audio Recording
Follow these instructions to optimize your audio recording.

1. Double-click the taskbar icon  to bring up the Realtek HD Audio Manager.
2. Click the Microphone tab.
3. Click the Noise Suppression button to prevent any background noise or 

feedback.
4. Click OK to close the Realtek HD Audio Manager.

 Figure 2 - 11
Optimizing Audio 

Recording
2 - 12 Audio Features
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Adding a Printer
The most commonly used peripheral is a printer. The following conventions will
help you to add a printer; however it is always best to refer to the printer manual for
specific instructions and configuration options.

USB Printer
Most current printers have a USB interface connection. You may use any one of the
ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink car-

tridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you 

to supply one. Follow the on-screen instructions.

Parallel Printer
This is still a very common type of printer. The install instructions are in the sidebar,
however you will need to purchase a parallel to USB converter.


Parallel Printer

After setting up the print-
er attach the parallel ca-
ble to the printer.

Connect the printer’s
parallel cable to the Par-
allel to USB converter,
and then plug the con-
verter into the USB port.

Turn ON the printer,
then turn ON the com-
puter.

Windows will identify the
printer and either load
one of its own drivers or
ask you to supply one.
Follow the on-screen in-
structions.
Adding a Printer 2 - 13
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the LCD and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Energy Star Power Saving
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system. 

(Note: All pictures used
on the following pages
are from the Windows 7
OS.)
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “How do I completely discharge the battery?”
on page 3 - 15).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 11.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options in the Windows control panel to configure this feature.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.

Power Button as 
Stand by or 

Hibernate Button

You can use the OS’s
Power Options control
panel to set the power
button to send the sys-
tem into Stand by or Hi-
bernate mode (see your
OS’s documentation, or
“Configuring the Pow-
er Buttons” on page 3
- 8 for details).


Shut Down

Note that you should always shut your computer down by choosing the Shut Down com-
mand from the bottom right of the Start menu in Windows. This will help prevent hard disk
or system problems.
Turning On the Computer 3 - 3
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 9 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 1
Power Plan 

Advanced Settings
(Win 7)
3 - 4 Power Plans
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 2
Power Plans (Win 7)

Click to Show/Hide 
additional 
power plans
Power Plans 3 - 5
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 7 uses the Sleep, Hibernate and Shut Down power-saving states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.
3 - 6 Power-Saving States
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 3
Start Menu Power
Power-Saving States 3 - 7
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 4
Power Options 
Define Power 

Buttons
3 - 8 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.

Table 3 - 1
Resuming 

Operation


3.75G/HSPA 

Modules & System 
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 9
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Energy Star Power Saving
This system supports Energy Star power management features that place comput-
ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. If you want to enable Energy Star power saving then follow these in-
structions:

1. Right-click the taskbar icon  (see sidebar).
2. Select Power Conservation Modes.
3. Select Energy Star to use the Energy Star power management and override other 

power saving settings.


Taskbar Icon

If the taskbar icon does
not appear then click the
taskbar arrow and select
Customize.

Select Show icon and
notifications alongside
the Hot key icon and
click OK. The  icon
will now appear in the
taskbar.

Figure 3 - 5
Energy Star Menu


Conservation Modes

The default Energy Star setting
will result in maximum power sav-
ing, but with the possible loss of
some performance.
Setting the mode to Balance will
give power saving matched with
performance. 
Performance will give optimum
computer performance but with
less power conservation.
3 - 10 Energy Star Power Saving
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 1 on page 3 - 4).

Click the battery icon  in the taskbar to see the current battery level and charge
status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 6
Battery Icon 

(Taskbar) & Battery 
Advanced Settings
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 3 - 7
Windows Mobility 

Center


Windows Mobility 

Center

The Windows Mobili-
ty Center control pan-
el provides an easy
point of access for in-
formation on battery
status, power plans
used and wireless de-
vice status etc.

Make sure Wireless is ON to ensure proper function key behavior.
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 15 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 11 for more information on how to maintain and properly
recharge the battery pack.)
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your service center. If the battery has been dropped we do
not recommend using it any further, as even if the computer continues to work with a dam-
aged battery in place, it may cause circuit damage, which may possibly result in fire. It is
recommended that you replace your computer battery every two years.
3 - 14 Battery Information
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 8
Power Plan Create
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 9
Change Plan 

Settings / Change 
Advanced Power 

Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 0%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 10
Power Options 

Advanced Settings - 
Battery
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of
the computer’s subsystems. The system takes advantage of some newer hardware components for which the lat-
est versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system
components won’t be auto-configured with an appropriate driver or utility during operating system installation.
Instead, you need to manually install some system-required drivers and utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and utilities necessary for the proper
operation of the computer. Table 4 - 1, on page 4 - 3 lists what you need to install and it is very important that
the drivers are installed in the order indicated.

Module Driver Installation
The procedures for installing drivers for the PC Camera, Wireless LAN, 3.75G/HSPA and Fingerprint mod-
ules are provided in “Modules & Options” on page 7 - 1.
What to Install 4 - 1
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Windows 7 Driver Installation
Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers/Option Drivers (button).

Figure 4 - 1 - Drivers Installer Screen 1

1. Check the driver installation order from Table 4 - 1, on page 4 - 3 (the drivers must be installed in this order) 
which is the same as that listed in the Drivers Installer menu below.

2. Click to select the driver you wish to install, (you should note down the drivers as you install them).
3. Follow the instructions for each individual driver installation procedure as listed on the following pages.
4 - 2 Windows 7 Driver Installation
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Figure 4 - 2 - Drivers Installer Screen 2
Table 4 - 1 - Driver Installation

Model A
Computers

Model B
Computers

Driver Win 7

Chipset Page 4 - 6

Video (VGA) Page 4 - 6

NVIDIA Video (VGA) Page 4 - 6

MEI Driver Page 4 - 6

Modem (Model A Only) Page 4 - 6

LAN Page 4 - 7

CardReader Page 4 - 7

Touchpad Page 4 - 7

Hot Key Page 4 - 7

USB 3.0 Page 4 - 7

Audio Page 4 - 7

PC Camera Module Page 7 - 8

Wireless LAN Module Page 7 - 16

3.75G/HSPA Module (Model A Only) Page 7 - 21

Fingerprint Reader Module (Model A Only) Page 7 - 30
Windows 7 Driver Installation 4 - 3
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
8 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Click Start, and click Control Panel (or point to 
Settings and click Control Panel).

2. Double-click Device Manager (Hardware and 
Sound > Device Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
4 - 4 Windows 7 Driver Installation
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. PC Camera, WLAN or
3.75G/HSPA) are ON before installing the appropriate
driver.
Windows 7 Driver Installation 4 - 5
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
Model A Computers
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
Model B Computers
1. Click 2.Install VGA Driver > Yes.
2. Click Yes > OK.

NVIDIA Video (VGA)
1. Click 3.Install nVIDIA VGA Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play/Display Settings control panel to adjust the vid-
eo settings to the highest resolution.

MEI Driver
1. Click 4.Install MEI Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish.

Modem
Model A Computers Only
1. Click 5.Install Modem Driver > Yes.
2. Click OK.
3. Click OK to restart the computer.
4. The modem is ready for dial-up configuration.

Go to the Phone and Modem (Options) control panel (Hardware and
Sound) and make sure the modem country selection is appropriate for
you.
4 - 6 Windows 7 Driver Installation
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LAN
1. Click 5./6.Install LAN Driver > Yes.
2. Click Install.
3. Click Finish.

CardReader
1. Click 6./7.Install Cardreader Driver > Yes.
2. Click Install.
3. Click Finish.

Touchpad
1. Click 7./8.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Hot Key
1. Click 8./9. Install Hotkey AP > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

USB 3.0
1. Click 9./10.Install USB 3.0 Driver > Yes. 
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Next > Install.
5. Click Finish.

Audio
1. Click 10./11.Install Audio Driver > Yes. 
2. Click Next.
3. Click Finish to restart the computer.

(See Over)
Windows 7 Driver Installation 4 - 7
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Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

Windows Experience Index
After the drivers are installed follow this procedure to
ensure an accurate rating from the Windows Experi-
ence Index (make sure the AC/DC adapter is plugged
in):

1. Click Start, and click Control Panel.
2. Click Performance Information and Tools 

(System and Security > System > Check the 
Windows Experience Index).

3. Click “Rate this computer/Refresh Now/Re-
run the assessment”.

4. The computer will take a few minutes to assess 
the system performance.

5. Close the control panel.


Windows Update

After installing all the drivers make sure you enable Windows
Update in order to get all the latest security updates etc. (all up-
dates will include the latest hotfixes from Microsoft).

To enable Windows Update make sure you are connected
to the internet:

1. Click Start, and click Control Panel (or point to Settings 
and click Control Panel).

2. Click Windows Update (System and Security/Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you need to be 

connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the updates.
4 - 8 Windows 7 Driver Installation
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Optional Drivers
See the pages indicated for the driver installation procedures for any modules included in your purchase option.

Figure 4 - 3 - Drivers Installer - Option Drivers Menu
Windows 7 Driver Installation 4 - 9
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Bluetooth Module
Note: The operating system is the default setting for
Bluetooth control in Windows 7 and does not require
a driver. See “Bluetooth Module” on page 7 - 2 for
configuration instructions.

PC Camera Module
See the introduction in “PC Camera Module” on
page 7 - 7, and check the installation procedure.

Wireless LAN Module
See the introduction in “Wireless LAN Module” on
page 7 - 15, and check the installation procedure.

3.75G/HSPA Module
Model A Computers Only
See the introduction in “3.75G/HSPA Module” on
page 7 - 21, and check the installation procedure.

Fingerprint Module
Model A Computers Only
See “Fingerprint Reader Module” on page 7 - 30 for
configuration instructions.
4 - 10 Windows 7 Driver Installation
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility 
If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Power-On Self Test (POST)
Each time you turn on the computer, the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.


POST Screen

1.BIOS information
2.CPU type 
3.Memory status
4.Enter Setup prompt

appears only during
POST

Note: The POST screen
as pictured right is for
guideline purposes only.
The POST screen on
your computer may ap-
pear slightly different. If
you disable the Boot-
time Diagnostic Screen,
the POST screen will not
appear.

Figure 5 - 1
POST Screen

1

2
3

4

5 - 2 The Power-On Self Test (POST)
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup 

Press F1 to see if the boot process can continue. It may work, without the correct
configuration. 

Press F2 to run the Setup program and try to correct the problem. If you still get an
error message after you change the setting, or if the “cure” seems even worse, call
for help.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Set-
up Defaults with <F9>.
The Power-On Self Test (POST) 5 - 3
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The Setup Utility
The Phoenix SecureCore(tm) Setup Utility tells the system how to configure itself
and manage basic features and subsystems (e.g. port configuration).

Entering Setup
To enter Setup, turn on the computer and press F2 during the POST. The prompt
(Press F2 to Enter Setup) seen on page 5 - 2 is usually present for a few seconds
after you turn on the system. If you get a “Keyboard Error”, (usually because you
pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.
5 - 4 The Setup Utility
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Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with menu headings. When you select a
heading, a new screen appears. Scroll through the features listed on each screen to
make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the
screen. If these tools are confusing, press F1 to call up a General Help screen, and
then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted
item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.
The Setup Utility 5 - 5
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
5 - 6 Main Menu
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SATA Port 1/2/3 (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Port 1/2/3. Use the Auto (Type:) setting to have the
items configured automatically for you.

System/Extended Memory (Main Menu)
This item contains information on the system memory, and is not user configurable.
The system will auto detect the amount of memory installed.

BIOS Revision/KBC/EC Firmware Revision (Main Menu)
This item contains information on the current BIOS and firmware versions.

GPU Card/GPU VBIOS Revision/GPU VBIOS Build Date (Main Menu)
This item contains information on the current video card and video BIOS.
Main Menu 5 - 7
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Advanced Menu

Advanced Chipset Control (Advanced Menu)
The sub-menu here allows you to enable/disable the JMicron Power Saving (as
used by the card reader) control, and to adjust the amount of Total Graphics Mem-
ory used by the system.

Figure 5 - 3
Advanced Menu
5 - 8 Advanced Menu
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Total Graphics Memory (Advanced Menu > Advanced Chipset Control)
Use this menu item to set the amount of system memory to be allocated for use by
Intel® Dynamic Video Memory Technology for the graphics device. The default
memory size allocated is MaxDVMT (up to 1748MB) and this may be adjusted to
128MB or 256MB (by pressing the spacebar to adjust) if required (see “Dynamic
Video Memory Technology” on page B - 6).

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in either IDE (native/
compatible) or AHCI (Advanced Host Controller Interface) modes from this menu.
The SATA mode should be set to AHCI mode for this system (unless you are sure
your hard disk can only operate in IDE mode). If you are unsure of the mode your
hard disk supports contact your service center.

Legacy USB Support: (Advanced Menu)
Choose “Enabled” if you intend to use USB devices in systems which do not nor-
mally support USB functionality (e.g. DOS). The default setting is “Enabled” and
does not need to be changed if you intend to use your USB devices in Windows.

Boot-time Diagnostic Screen (Advanced Menu)
Use this menu item to enable/disable the Boot-time Diagnostic Screen or POST
screen (see “The Power-On Self Test (POST)” on page 5 - 2).


SATA Mode 

Selection

If you have installed the
Windows 7 operating
system with AHCI mode
enabled (default set-
ting), DO NOT disable
AHCI mode (if you wish
to disable AHCI mode
you will need to reinstall
the Windows 7 OS).
Advanced Menu 5 - 9
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Legacy OS Boot: (Advanced Menu)
Enable this item to support only system boot from the Legacy OS (e.g Windows Vis-
ta). If disabled the system will attempt to boot from the EFI (Extensible Firmware
Interface) before the Legacy OS.

Power on Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Phoenix SecureCore(tm) Setup Utility.
This will not affect access to the computer OS, (only the Phoenix SecureCore(tm)
Setup Utility).


Security Menu

The changes you
make here affect the
access to the Setup
utility itself, and also
access to your ma-
chine as it boots up af-
ter you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in
your software OS.

Figure 5 - 4
Security Menu
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Set User Password (Security Menu)
You can set a password for user mode access to the Phoenix SecureCore(tm) Setup
Utility. This will not affect access to the computer OS, (only the Setup utility) unless
you choose to set a Password on Boot (see below). Many menu items in the Phoenix
SecureCore(tm) Setup Utility cannot be modified in user mode. You can only set
the user password after you have set the supervisor password.

Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 

Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
5 - 12 Security Menu
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot priority order. Item specific help on the right is avail-
able to help you move devices up and down the order.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 

Figure 5 - 5
Boot Menu
Boot Menu 5 - 13



BIOS Utilities

5

Exit Menu

Choosing to Discard Changes, or Exit Discarding Changes, will wipe out any
changes you have made to the Setup. You can also choose to restore the original Set-
up defaults that will return the Setup to its original state, and erase any previous
changes you have made in a previous session.

Figure 5 - 6
Exit Menu
5 - 14 Exit Menu
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Chapter 6: Upgrading The Computer

Overview
This chapter contains information on upgrading the computer. Follow the steps out-
lined to make the desired upgrades. If you have any trouble or problems you can con-
tact your service representative for further help. Before you begin you will need:

• A small crosshead or Phillips screwdriver
• A small regular slotted (flathead) screwdriver
• An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic
wrist strap to ground yourself because static electricity may damage the compo-
nents.

The chapter includes:

• Removing the Battery
• Upgrading the Hard Disk Drive
• Upgrading the Optical (CD/DVD) Device
• Upgrading the System Memory (RAM)
• Changing the Optional LCD Back Covers

Please make sure that you review each procedure before you perform it.


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.
Overview 6 - 1



Upgrading The Computer

6

When Not to Upgrade
These procedures involve opening the system’s case, adding and sometimes replac-
ing parts.

You should not perform any of these upgrades if:

• Your system is still under warranty or a service contract
• You don’t have all the necessary equipment 
• You’re not in the correct environment
• You doubt your abilities

Under any of these conditions, contact your service representative to purchase or re-
place the component(s).

Upgrading the Processor
If you want to upgrade your computer by replacing the existing processor with a fast-
er/new one you will need to contact your customer service representative. We rec-
ommend that you do not do this yourself, since if it is done incorrectly you may
damage the processor or mainboard.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and disconnect-
ed all peripherals and
cables (including tele-
phone lines). It is advis-
able to also remove your
battery in order to pre-
vent accidentally turning
the machine on.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember
to replace the cover(s) and screw(s) before turning the computer on.
6 - 2 Overview
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Removing the Battery
If you are confident in undertaking upgrade procedures yourself, for safety reasons
it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Slide the battery out in the direction of the arrow .


Warranty Warning

Please check with your
service representative
before undertaking any
upgrade procedures to
find out if this will VOID
your warranty.

Figure 6 - 1
Battery Removal
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Upgrading the Hard Disk Drive
The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard
disk drives with a height of 9.5mm (h) (see “Storage” on page C - 3). Follow your
operating system’s installation instructions, and install all necessary drivers and util-
ities (see “Windows 7 Driver Installation” on page 4 - 2), when setting up a new
hard disk.


HDD System 

Warning

New HDD’s are blank. Be-
fore you begin make sure:
You have backed up any
data you want to keep from
your old HDD.
You have all the discs re-
quired to install your oper-
ating system and
programs.
If you have access to the in-
ternet, download the latest
application and hardware
driver updates for the oper-
ating system you plan to in-
stall. Copy these to a
removable medium.
6 - 4 Upgrading the Hard Disk Drive
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1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  & .
3. Remove the hard disk bay cover .

Figure 6 - 2
Hard Disk Bay 
Cover Removal
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4. Slide the hard disk in the direction of arrow .
5. Lift the hard disk out of the bay .
6. Remove the screw(s)  -  and the adhesive cover .
7. Reverse the process to install a new hard disk drive (do not forget to replace all the 

screws and covers).


Hard Disk Screws & 

Cover

The hard disks and cov-
ers pictured here may
appear slightly different
from your model design
(these designs are sub-
ject to change and up-
grade without notice).
Pay careful attention to
the screws (if included)
and cover orientation.

Figure 6 - 3
Hard Disk Removal
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Upgrading the Optical (CD/DVD) Device
1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws  & .
3. Remove the hard disk bay cover .
4. Slide the hard disk in the direction of arrow  and lift the hard disk out of the bay.

Figure 6 - 4
Hard Disk Removal
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5. Remove the screw at point , and use a screwdriver to carefully push out the 
optical device at point .

6. Reverse the process to install the new device.
7. Replace the hard disk bay cover.

Figure 6 - 5
Removing the 
Optical Device
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Upgrading the System Memory (RAM)
The computer has two memory sockets for 204 pin Small Outline Dual In-line (SO-
DIMM) DDRIII (DDR3) type memory modules (see “Memory” on page C - 2 for
details of supported module types).

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the component bay cover and remove screws  - .
3. Carefully (a fan and cable are attached to the under side of the cover) lift up 

the bay cover.
4. Carefully disconnect the fan cable , and remove the cover . 


Fan Cable

Make sure you recon-
nect the fan cable 
before screwing down
the bay cover.

Figure 6 - 6
Removing the 

Component Bay 
Cover
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5. Gently pull the two release latches on the sides of the memory socket in the 
direction indicated by the arrows (  & ) in Figure 6 - 7.

6. The RAM module will  pop-up, and you can remove it.

Figure 6 - 7
RAM Module 

Release Latches


Contact Warning

Be careful not to touch
the metal pins on the
module’s connecting
edge. Even the clean-
est hands have oils
which can attract parti-
cles, and degrade the
module’s perfor-
mance.

Figure 6 - 8
RAM Module 

Removal

7 8

7 8

9

9


Single Memory Module 

Installation

If your computer has a single memory
module, then insert the module into the
Channel 0 (JDIMM1) socket. In this
case this is the lower memory socket
(the socket closest to the mainboard).
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7. Pull the latches to release the second module if necessary.
8. Insert a new module holding it at about a 30° angle and fit the connectors firmly 

into the memory slot.
9. The module’s pin alignment will allow it to only fit one way. Make sure the module 

is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit 
without much pressure.

10. Press the module in and down towards the mainboard until the slot levers click into 
place to secure the module.

11. Replace the bay cover (see sidebar) and screws (make sure you reconnect the 
fan cable, and hook it under the retaining pins, before screwing down the 
bay cover).

12. Restart the computer to allow the BIOS to register the new memory configuration 
as it starts up.


Cover Pins

Note that the computer
has five cover pins.
These pins need to be
aligned with slots in the
case to insure a proper
cover fit, before screw-
ing down the bay cover.

Figure 6 - 9
Cover Pin 
Alignment
Upgrading the System Memory (RAM) 6 - 11
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Changing the Optional LCD Back Covers
If your purchase option includes the specially designed changeable LCD back cover
option, then follow the instructions below to change the covers (note these covers
are not applicable to all models in this series - consult your service center for details).

1. Open the LCD and carefully remove the rubber screw covers  &  and set 
them aside.

2. Remove screws  &  from the front cover.


Rubber Screw 

Covers

After removing the rub-
ber screw covers,
place them on a clean
dry surface (or attach
them to the front cover
itself) in order to pre-
vent loss of adhesive.

Figure 6 - 10
Removing the 

Covers & Screws
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3. Carefully slide the cover forward in the direction of the arrows  &  as 
illustrated below.

4. Remove the LCD back cover .

Figure 6 - 11
Slide the Cover 

Forward

Figure 6 - 12
Remove the LCD 

Back Cover
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5. Align the replacement cover with the top of the LCD  as illustrated below (and 
as marked on the cover).

6. Slide the cover forward slightly until it clicks firmly into place .
7. Run your hands around the sides and front of the cover  to make sure it is firmly 

aligned in place (carefully press down to make sure the fit is secure).
8. Replace the screws and rubber covers (see Figure 6 - 10 on page 6 - 12).

Figure 6 - 13
Replacing the LCD 

Back Cover
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Chapter 7: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

• Bluetooth Module
• PC Camera Module
• Wireless LAN Module
• 3.75G/HSPA Module
• Fingerprint Reader Module


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the mod-
ule(s) are OFF if you are
using the computer
aboard aircraft. 


Important Notice

If your purchase option includes both Wireless LAN and 3.75G/HSPA modules, then the
appropriate antennas will be installed. Note that In order to comply with FCC RF exposure
compliance requirements, the antenna must not be co-located or operate in conjunction
with any other antenna or transmitter.
Overview 7 - 1
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Bluetooth Module
If your purchase option includes a Bluetooth module, then the operating system’s
Bluetooth Devices control panel is used to configure the Bluetooth settings in Win-
dows 7, and therefore does not require a driver. Use the Fn + F12 key combination
to toggle power to the Bluetooth module. When the Bluetooth module is powered
on the indicator  will briefly be displayed.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F12 key com-
bination to toggle power to
the Bluetooth module, and
check the LED indicator to
see if the module is pow-
ered on or not (see Table 1
- 5, on page 1 - 12/ Table 1
- 3, on page 1 - 9).


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported in
one direction only (simultaneous data transfer is not supported). Therefore if you are copying a
file from your computer to a Bluetooth enabled device, you will not be able to copy a file from the Blue-
tooth enabled device to your computer until the file transfer process from the computer has been com-
pleted.

Bluetooth Module & Resuming From Sleep Mode

The Bluetooth module’s default state will be off after resuming from the Sleep power-saving state. Use
the key combination (Fn + F12) to power on the Bluetooth module after the computer resumes from
Sleep.
7 - 2 Bluetooth Module
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Bluetooth Configuration in Windows 7

Setup your Bluetooth Device so the Computer Can Find it
1. Turn your Bluetooth device (e.g. PDA, mobile phone etc.) on.
2. Make the device discoverable (to do this check your device documentation).

To Turn the Bluetooth Module On
1. Press the Fn + F12 key combination to power on the Bluetooth module. 
2. A Bluetooth icon  will appear in the taskbar.
3. You can then do any of the following to access the Bluetooth Devices control

panel.

• Double-click the taskbar icon  to access the Bluetooth Devices control panel.

• Click/Right-click the taskbar icon  and choose an option from the menu.


Add a Device

Click Start, and click
Control Panel and then
click Devices and
Printers (Hardware
and Sound). Click Add
a device to search for
any available Bluetooth
devices.

Figure 7 - 1
Bluetooth Devices & 

Click Icon Menu

Add a device

Right-Click Taskbar Icon 
Bluetooth Module 7 - 3



Modules & Options

7

To Add a Bluetooth Device
1. Access the Bluetooth Devices control panel and click Add a device.
2. Double-click the device you want to pair with the computer.

3. On first connection the computer will provide you with a pairing code to be entered 
onto the device.


Pairing Options

If a device has been pre-
viously connected then
the pairing option menu
will appear when you at-
tempt subsequent con-
nections. You can choose
to have the computer cre-
ate a pairing code for you,
use the device’s existing
pairing code or you can
pair certain devices with-
out using a code.

Figure 7 - 2
Add a Device
7 - 4 Bluetooth Module
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4. Enter the code into your Bluetooth enabled device and follow any on-screen
instructions to complete the pairing.

5. Windows will check to see if any drivers are required to complete the pairing. 
6. Follow any on-screen instructions on the computer if device drivers are required to

be installed.
7. Click Close.

Figure 7 - 3
Pairing Code 

Example

Figure 7 - 4
Pairing Complete & 
Bluetooth Device 

Enabled


Pairing Codes

The example outlined here shows a connection to
a mobile device. Other devices e.g. computers,
may have a slightly different connection proce-
dure, and may require you to confirm a pairing
code is correct on both devices. Follow the on-
screen instructions to complete the pairing.
Bluetooth Module 7 - 5
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To Change Settings for the Bluetooth Device
1. Click the taskbar icon and select Show Bluetooth Devices.
2. Right-click on the device you want to change and click Properties to:

• Change the name of the device (click Bluetooth, type a new name and click OK).
• Enable/Disable a service (click Services, clear/tick the check box next to the service and click OK).

To Make your Computer Discoverable to Bluetooth Devices
1. Click the taskbar icon and select Open Settings.
2. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
3. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.


Bluetooth Help

To get help on Bluetooth
configuration and set-
tings, select Help and
Support from the Start
menu. Type Bluetooth in
the Search Help box, and
select an item from the re-
turned search results to
get more information.

Figure 7 - 5
Bluetooth Settings - 

Options
7 - 6 Bluetooth Module
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PC Camera Module
Before installing the PC Camera driver, make sure that the optional PC Camera is
on. Use the Fn + F10 key combination (see “Function/Hot Key Indicators” on
page 1 - 12) or hot key button  to toggle power to the PC Camera module.
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.
When the PC Camera module is powered on, the indicator  will briefly be dis-
played.

There are a number of different camera modules available with this computer model
series. You will have the appropriate application installed for your camera. Make
sure you access the application via the desktop shortcut.


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here.
PC Camera Module 7 - 7
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PC Camera Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install Webcam Driver > Yes.
4. Choose the language you prefer and click Next > Next > Finish.

OR
Click Next > Next > Install > Finish to restart the computer.
OR
Click Next > Next > Install > Finish to restart the computer.
OR
Choose the language you prefer and click Next > Next > Finish to restart 
the computer.
OR
Click Next > Install > Finish to restart the computer.

5. Run the camera application program from the desktop shortcut (if the hard-
ware is turned off use the Fn + F10 key combination to turn it on again).


PC Camera Screen 

Refresh

The PC Camera module
supports a frame rate of
12 fps. If you find that
the screen refresh rate
is subject to lag or stut-
tering, then reduce the
window size, or adjust
the Output Size and/or
Color Space Compres-
sion. 

To reduce Output Size
and/or Color Space
Compression run the
camera application,
click Options and select
Video Capture Pin. Ad-
just the settings from the
appropriate pull-down
menu.
7 - 8 PC Camera Module



Modules & Options

7

PC Camera Audio Setup
If you wish to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Click Sound  (Hardware and Sound).
3. Click Recording (tab).
4. Right-click Microphone (Realtek High Definition Audio) and make sure the item is 

not disabled.
5. Double-click Microphone (or select Properties from the right-click menu).
6. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
7. Click OK and close the control panels.
8. Run the camera application program from the desktop shortcut.
9. Go to the Devices menu heading and select Microphone (Realtek....) (it should 

have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick 

alongside it).
PC Camera Module 7 - 9
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Figure 7 - 6
Audio Setup for PC 

Camera

Right-click
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Camera Application
The camera application is a video viewer for general purpose video viewing and test-
ing, and for capturing video files to .avi format.

1. Run the camera application from the desktop shortcut (it is recommended that you 
set the capture file before the capture process - see Set Capture File below).

2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera 
Audio Setup” on page 7 - 9) and select Start Capture.

3. Click OK (the file location will be displayed in the pop-up box) to start capturing the 
video, and press Esc to stop the capture (you can view the file using the Windows 
Media Player).

Set Capture File
Prior to capturing video files you may select the Set Capture File... option in the
File menu, and set the file name and location before capture (this will help avoid ac-
cidentally overwriting files). Set the name and location then click Open, then set the
“Capture file size:” and click OK. You can then start the capture process as above.

Note the important information in “Reducing Video File Size” on page 7 - 12 in or-
der to save file space, and help prevent system problems.


Pre-Allocating File 

Space

You may pre-allocate the
file size (File > Allocate
File Space) for the cap-
ture file in the camera ap-
plication.

Pre-allocating space on
the hard disk can improve
the capture quality (par-
ticularly of large capture
files), by reducing the
amount of work the hard
disk has to do in finding
space for the video data
as it is being captured.

See also “Reducing Vid-
eo File Size” on page 7 -
12.
PC Camera Module 7 - 11
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Reducing Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows system requires a minimum of 15GB of free space on the C:
drive system partition. In order to prevent system problems it is recommended that
you save the captured video file to a location other than the C: drive (see “Set Cap-
ture File” on page 7 - 11), limit the file size of the captured video (see “Pre-Allo-
cating File Space” on page 7 - 11) or reduce video resolution (see below).

To Reduce Video Resolution Output Size:

1. Run the camera application program from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Pin....
3. Click the Output Size drop box and select a lower resolution size in order to 

reduce the captured file size.
4. Click OK.
7 - 12 PC Camera Module
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Eliminating Screen Flicker
If you find that the video screen in the camera program is flickering, you can try to
adjust the setting in the Video Capture Filter options.

1. Run the camera application from the desktop shortcut.
2. Go to Options and scroll down to select Video Capture Filter....
3. Click either 50Hz or 60Hz under Anti Flicker/Frequency/Powerline Frequency.


Latest PC Camera 
Driver Information

Check the Device Driv-
ers & Utilities + User’s
Manual disc, and any
accompanying insert
pages, for the latest up-
dated information on the
PC Camera driver,
which may override the
information provided
here, including the fig-
ures pictured.

Figure 7 - 7
Video Capture Filter
PC Camera Module 7 - 13
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Zoom (if supported by application)
The WebCam program allows you to zoom the camera in and out (note the zoom
function is not available in all camera model applications).

1. Run the camera application from the desktop shortcut.
2. Go to Zoom and select Zoom Out/Zoom In.

Taking Still Pictures
The WebCam program allows you to take still pictures.

1. Run the camera application from the desktop shortcut.
2. Go to Options and select Take Picture.
3. The picture (in JPEG format) will be placed in the Snapshot folder  on the 

desktop.

Figure 7 - 8
Zoom/Setting


Snapshot Folder

The Snapshot folder’s
default location is on the
desktop. Do not move
this folder or an error
may appear when you
try to take a still picture.

If you accidentally de-
lete or move the folder,
you can create a new
Snapshot folder on the
desktop in order to cap-
ture the files.
7 - 14 PC Camera Module



Modules & Options

7

Wireless LAN Module
If you have included an Intel® Wi-Fi Link 6200/6300 Series or 3rd Party 802.11b/
g/n WLAN module in your purchase option, make sure that the Wireless LAN mod-
ule is on before installing the driver. 

Use the Fn + F11 key combination (see “Function/Hot Key Indicators” on page 1
- 12) or hot key button  to toggle power to the Wireless LAN module. Make
sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3. When
the WLAN module is powered on the indicator  will briefly be displayed.

Wireless should be turned ON in the Windows Mobility Center to ensure proper
wireless function key behavior (see “Wireless Hot Keys” on page 3 - 12).


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn + F11 key com-
bination or hot key button to
toggle power to the WLAN
module, and check the indi-
cator to see if the module is
powered on or not (see
Table 1 - 5, on page 1 - 12/
Table 1 - 3, on page 1 - 9).
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802.11b/g/n Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, and then insert the Device Drivers 
& Utilities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Choose the language you prefer and click Next.
5. Click Next > Install.
6. Click Finish to restart the computer.

Intel® Wi-Fi Link Series Driver Installation
If you see the message “Found New Hardware” click Cancel to close the window.

1. Make sure the module is powered on, and then insert the Device Drivers 
& Utilities + User’s Manual disc into the CD/DVD drive. 

2. Click Option Drivers (button).
3. Click 2.Install WLAN Driver > Yes.
4. Click Next > Next.
5. Click the button to accept the license and click Next.
6. Click Next > Next > Finish.

Note: The operating system is the default setting for Wireless LAN control in Win-
dows (see overleaf).
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Connecting to a Wireless Network in Windows 7
Make sure the Wireless LAN module is turned on.

1. Click the taskbar wireless icon , and then double-click an access point to con-
nect to or click to Open Network and Sharing Center if you do not see a network 
you want to connect to in the taskbar menu (a list of options will appear allowing 
setting changes, and creating a new network).


Network and 

Sharing Center

You can also use the Net-
work and Sharing Cen-
ter control panel in
Windows (Network and
Internet) to connect to
any available wireless
networks.

Figure 7 - 9
Click Taskbar Icon 
Menu & Network 

and Sharing Center
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2. You may need to enter a security key for any access point to which you are trying 
to connect.

3. Click to select a network location (e.g. Home, Work or Public).
4. Click “View or change settings in Network and Sharing Center” to access 

further options for the connection.

Figure 7 - 10
Network Location 

Set
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5. Click the taskbar icon  to see any currently connected networks.
6. To disconnect from the wireless network you can click the taskbar wireless icon ,

click the active connection and then click Disconnect (button).


Security Enabled 
Networks

You should try to make
sure that any network you
are connecting to is a se-
cure network.

Connecting to unsecure
networks may allow unau-
thorized access to your
computer, documents,
websites and files etc.

Figure 7 - 11
Click Taskbar Icon 

Menu - Disconnect
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Windows Mobility Center
The Windows Mobility Center control panel provides an easy point of access for
information on battery status, power plans used and wireless device status etc.

To access the Windows Mobility Center:

1. Click Start, and click Control Panel (or point to Settings and click Control 
Panel).

2. Double-click Windows Mobility Center (Mobile PC).
3. Click the button to Turn wireless off/on, or click the icon  to access the network 

menu.


Wireless Hot Keys

The computer’s wireless
function keys will not func-
tion properly if Wireless is
turned OFF in the Win-
dows Mobility Center
control panel.

The wireless indicators
 may show that

the WLAN module is pow-
ered on, however if wire-
less is OFF in the Mobility
Center, the module will not
be powered on. 

Make sure that Wireless is
ON in the Mobility Center to
ensure proper function key
behavior.

Figure 7 - 12
Windows Mobility 

Center
Make sure Wireless is ON to ensure proper function key behavior.
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3.75G/HSPA Module
If you have included an optional (for Model A Only) 3.75G/HSPA (High Speed
Packet Access) module (see “Communication” on page C - 3 for specification de-
tails) in your purchase option, you will have the appropriate application provided for
your module. Follow the instructions on page 7 - 22 to install the USIM card (which
will be provided by your service provider), and then install the application.


3.75G/HSPA 

Modules & System 
Wake Up

Note that the 3.75G mod-
ules DO NOT support
system wake up on
3.75G/HSPA modem ac-
tivity.


Important Notice - 3.75G/HSPA & Bluetooth/Wireless LAN Modules

In order to comply with FCC regulations you should NOT operate the 3.75G/HSPA module
and the Bluetooth/Wireless LAN modules at the same time as this may disrupt radio fre-
quency, and cause interference. When the 3.75G/HSPA module is powered on, make sure
that the Bluetooth/Wireless LAN modules are powered off.
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3.75G/HSPA Module USIM Card Installation
Follow the instructions below to install the USIM card (which will be provided by
your service provider).

1. Turn off the computer, and turn it over.
2. Slide the latch  in the direction of the arrow.
3. Slide the latch  in the direction of the arrow, and hold it in place.
4. Remove the battery.
5. Insert the USIM card (at the rear of the battery compartment) as illustrated below 

until it clicks fully into position, and replace the battery.


Power Safety 

Warning

Before you undertake any
installation procedures,
make sure that you have
turned off the power, and
disconnected all peripher-
als and cables (including
telephone lines). It is advis-
able to also remove your
battery in order to prevent
accidentally turning the ma-
chine on.

USIM Card Orientation

Note that the USIM card’s
readable side (with the
gold-colored contacts)
should face upwards as il-
lustrated.

Figure 7 - 13
Battery Removal & 

USIM Card Insertion

1
2

1
2
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Before installing the application, make sure that the 3.75G/HSPA module is ON
(installing the driver with the module off will not allow the software to detect the
module hardware correctly). Use the Fn +  key combination (see Table 1 - 5, on
page 1 - 12) to toggle power to the 3.75G/HSPA module. When the 3.75G/HSPA
module is powered on, the indicator  will briefly be displayed. Make sure you in-
stall the drivers in the order indicated in Table 4 - 1, on page 4 - 3. Note that exiting
the application does NOT turn off the 3.75G/HSPA module.

• Mobile Partner - See “Mobile Partner Application Installation” on page 7 - 
24 for driver installation information and “Mobile Partner Application” on 
page 7 - 25 for instructions on using the Mobile Partner application.
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Mobile Partner
With the 3.75G/HSPA module and USIM card (supplied by your service provider)
installed you may then install the Mobile Partner application. The Mobile Partner
application allows you to directly access your HSPA internet service from the com-
puter.

Mobile Partner Application Installation

1. Enable power to the module by pressing the Fn +  key combination (give 
the module about 10 seconds to power on - the on screen icon  will 
indicate the module’s power status). If a Found New Hardware window 
appears, click Cancel in all windows that appear, and then proceed to install 
the driver as below.

2. Make sure the module is powered on, and then insert the Device Drivers & 
Utilities + User’s Manual disc into the CD/DVD drive. 

3. Click Option Drivers (button).
4. Click 3.Install 3G Driver > Yes. 
5. Choose the language you prefer and click OK > Next.
6. Click I Agree (button) to accept the license agreement.
7. Click Next > Install.
8. Click Finish.
9. Access the Mobile Partner application from the Start menu (Start > Pro-

grams/All Programs > Mobile Partner), or by double-clicking the Mobile 
Partner icon on the desktop.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission de-
vices aboard aircraft is usu-
ally prohibited. Make sure
the module(s) are OFF if
you are using the computer
aboard aircraft.

Use the Fn +  key com-
bination to toggle power to
the 3.75G/HSPA module,
and check the indicator to
see if the module is pow-
ered on or not (see Table 1
- 5, on page 1 - 12/ Table 1
- 3, on page 1 - 9).
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Mobile Partner Application
You will need to contact your service provider to obtain the exact details of how ex-
actly to configure the settings on this page.

Profile Management
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. If you have not created a profile, click Tools and select Options, and then click 
Profile Management.

4. Click New  and input the appropriate information for Profile Name, APN 
and Authentication etc. as supplied by your service provider.

5. Click Save  to save the profile.


Mobile Partner Help

To get help on Mobile
Partner configuration
and settings, click the
Help menu and select
Online Help or press
F1.

Figure 7 - 14
Profile Management
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Connecting to the Service Provider
1. Power on the 3.75G/HSPA module using the Fn +  key combination.
2. Access the Mobile Partner application from the Start menu (Start > Programs/

All Programs > Mobile Partner), or by double-clicking the Mobile Partner icon 
on the desktop .

3. The software will run and you can select the Profile Name from the menu.
4. Click Connect  to begin the connection process.

5. The Mobile Partner application will then display the connection information.

Figure 7 - 15 
Connect

Figure 7 - 16
Network 

Connection Prompt
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6. When the connection is successful you can move the cursor over the network icon 
in the taskbar to display the connection information.

7. You can then access the internet, download e-mail etc. as per any internet 
connection.

8. While you are connected the indicators in the Mobile Partner window will display 
uploading and downloading icons and a network icon in the taskbar .

9. To disconnect click the Disconnect  icon, or right click the taskbar icon 
and select Disconnect.

10. The program will disconnect from the service provider.

Figure 7 - 17
Connected 

Taskbar 
Notification

Figure 7 - 18
Disconnect
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11. The module will still be on, and you will need to press the Fn +  key combination 
to turn it off.

12. If you click the Mobile Partner close icon  a message will be displayed asking 
you to click OK to confirm the program exit and to terminate the connection. 

13. Exiting the program terminates the connection, but DOES NOT turn off the 3.75G/
HSPA module, and you will need to press the Fn +  key combination to turn off 
the module (pay careful attention to this aboard aircraft - see “Wireless Device 
Operation Aboard Aircraft” on page 7 - 24).

14. If the module is on and the computer enters a power-saving state, then the power 
status of the module on resuming from the power-saving state will be as below:

• If the 3.75G/HSPA module is on and the computer is Shut Down or Restarted; 
the module will be off when the computer starts up.

• If the 3.75G/HSPA module is on and the computer enters Sleep or Hibernate; 
the module will be off when the computer resumes from sleep.

Figure 7 - 19
Exit Prompt
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Text Messaging Service
In addition to standard internet services you may also send and receive SMS text
messages using the Mobile Partner program, if your service supports SMS.

Reading SMS Messages
1. An icon  will blink at the bottom of the Mobile Partner interface to notify you of 

any new messages received.
2. Click the Text icon  in the Mobile Partner Interface.
3. Select the Local > Inbox or SIM/USIM Card folder and select any message to 

read it.
4. Right-click the message and choose an option to reply, forward or delete the 

message.

Creating and Sending SMS Messages
1. Click the Text icon  in the Mobile Partner Interface.
2. Click the New button .
3. Enter the recipient’s number in the Send To... field or click the Send To... button to 

select an entry from the phone book, and click OK.
4. Type in the message details.
5. Click the Send button, Save button to send the message later or Close > Yes to 

save in the Draft folder.

For more details on SMS click the Help menu and select Online Help or press F1
and select SMS.
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Fingerprint Reader Module
The optional (for Model A Only) fingerprint reader Protector Suite Software
provides a high level of security for your computer. A further level of security and
control is provided in the BIOS (see “Security Menu” on page 5 - 11).

The fingerprint reader and Protector Suite Software allow you to:

• Access or Lock your computer
• Protect sensitive files
• Display and file your favorite web pages
• Fill in frequently used dialogs
• Run your favorite applications

If you have included the fingerprint reader in your purchase option you will need to
install the driver as per the instructions below. 

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection.

Before beginning the enrollment process it is recommended that you go through the
fingerprint tutorial. To run the tutorial click Start > Programs/All Programs >
Protector Suite QL > Fingerprint Tutorial after installing the driver.


Password Warning

If you set passwords for
any of the security mod-
ules, NEVER forget your
password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
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Fingerprint Reader Driver Installation
1. Make sure the module is powered on, and then insert the Device Drivers & 

Utilities + User’s Manual disc into the CD/DVD drive. 
2. Click Option Drivers (button).
3. Click 4.Install Fingerprint Driver > Yes.
4. Click Next > Next > Next.
5. Click Finish > Yes to restart the computer.


Help & Manual

Right-click the taskbar icon
 to bring up the menu to

select Help.
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User Enrollment
1. Click Start > Programs/All Programs > Protector Suite > Control Center, or 

double click the taskbar icon  (click Initialize).
2. On the first run of the program you will be asked to click the Accept button to 

accept the license.
3. If you have not set a Windows password you will be prompted to do so (note: If 

you have not set a password Protector Suite cannot secure access to your 
computer).

4. Click Submit when you have entered password.
5. You will then be prompted to enroll your fingerprints (you can click Tutorial to get 

help with fingerprint enrollment at any time).


Fingerprint 
Enrollment

Note that it is strongly rec-
ommended that you enroll
more than one finger in
case of injury etc. 

Figure 7 - 20
Fingerprint 
Enrollment

Tutorial
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6. Click the button above any of the fingers to begin the enrollment process for that 
finger.

7. Swipe the finger until the progress bar reaches 100% to enroll that finger.
8. Close the Protector Suite 2009 window.
9. Right-click the taskbar icon  and select Start Control Center (and then swipe a 

finger) to allow you to Edit Fingerprints, register Applications, edit Settings and 
access the Help menu etc. You can also run the Control Center etc. from the 
Protector Suite item in the Programs/All Programs menu

10. Click “Help” in Control Center Home to get more information on any topic.
11. You can also run the Tutorial, or Product Tour video to get more information.

12. See “Help & Manual” on page 7 - 31 for further details.
13. If you swipe your finger over the reader at any time you can access the Biomenu 

to lock the computer, register websites, access the Personal Safe, open the 
Control Center and access the Help menu.

Help
Figure 7 - 21

Control Center & 
Biomenu 
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Fingerprint Control Center Features

Application Launcher
The Application Launcher allows you to register applications to be launched when
assigned to a particular finger. Simply copy the application icon on to one of the reg-
istered fingers and ten click OK to close the application window. Once registered the
application will launch when you swipe the appropriate finger across the sensor.

Password Bank
The Password Bank stores registrations of user names, passwords and other set-
tings for web sites etc. 

Personal Safe
The Personal Safe is an encrypted area assigned on your hard drive that allows you
to store files and folders to be protected by fingerprint protection.


Help 

For more information on
these and other features
simply access “Help” in
the Fingerprint Control
Center and select the
item from the menu on
the left.
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Chapter 8: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
Overview 8 - 1
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 6), the Fn + F4 key combination, or 
power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
8 - 2 Basic Hints and Tips
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “The Power-On Self Test (POST)” on page 5 - 
2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and 
restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
8 - 6 Upgrading and Adding New Hardware/Software
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 4) check its settings. You may also be using
an ExpressCard/USB device/external device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 11).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device is consuming a lot of power. Turn off/remove
the unused device to save power.
Problems and Possible Solutions 8 - 7
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 16). Make sure you’re using the correct adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 8).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the Touchpad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix B for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
8 - 8 Problems and Possible Solutions
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows taskbar, or use the key combination Fn + F5 and
F6 (see “Function/Hot Key Indicators” on page 1 - 12) to adjust.

The CD/DVD cannot be read. The CD/DVD is dirty. Clean it with a CD/DVD cleaner kit.

The CD/DVD tray will not open when
there is a disc in the tray.

The CD/DVD is not correctly placed in the tray. Gently try to remove the disc
using the eject hole (see “Loading Discs” on page 2 - 3).

The DVD regional codes can no longer
be changed.

The code has been changed the maximum 5 times. See “DVD Regional
Codes” on page 2 - 5.

Unwelcome numbers appear when
typing.

If the LED  is lit, then Num Lock is turned ON. (see “LED Indicators” on
page 1 - 9).

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
Problems and Possible Solutions 8 - 9



Troubleshooting

8

The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 6). Make sure you have enabled Hibernate mode from the control
panel.

The Wireless LAN/Bluetooth/3.75G/
HSPA modules cannot be detected.

The modules are off. Check the LED indicator and/or function key indicator to
see if the WLAN/Bluetooth/3.75G/HSPA module is on or off (see “LED
Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11
(WLAN), Fn + F12 (Bluetooth) or Fn +  (3.75G/HSPA) key combination(s)
in order to enable the modules (see Table 1 - 5, on page 1 - 12).

Problem Possible Cause - Solution


Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
8 - 10 Problems and Possible Solutions
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The Wireless LAN indicators 
show that the WLAN module is powered
on, however the module does not connect.

The WLAN module is turned off in the Windows Mobility Center. The
computer’s wireless function keys will not function properly if Wireless is turned
OFF in the Windows Mobility Center control panel. Make sure that Wireless is
ON in the Mobility Center to ensure proper function key behavior (see
“Wireless Hot Keys” on page 3 - 12).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth/ PC
Camera/3.75G/HSPA modules cannot be
configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in “Modules & Options” on page 7 - 1).

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the device to your computer until
the file transfer process from the computer has been completed.

The Bluetooth module is off after
resuming from Sleep.

The Bluetooth module’s default state will be off after resuming from the Sleep
power-saving state. Use the key combination (Fn + F12) to power on the
Bluetooth module after the computer resumes from Sleep.

Problem Possible Cause - Solution
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I am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

The system is experiencing problems with
an attached e-SATA (external Serial
Advanced Technology Attachment) device.

Follow the instructions to install the Matrix Driver from the location indicated
below:

1. Insert the Device Drivers & Utilities + User’s Manual disc and click 
Browse CD/DVD. 

2. The driver is located in the following location on the disc: 
X:\Options\IMXM\iata_cd. 

3. Double-click the executable setup file and follow the on-screen instructions 
to install the driver.

Problem Possible Cause - Solution
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Bluetooth Connection Problems
If you are experiencing problems connecting to some Bluetooth devices (in particular certain mobile phones and
headsets) it maybe necessary to download and install the Windows Mobile Device Center software (for Win-
dows Vista and Windows 7). Go to the Microsoft website and search for the Microsoft Windows Device Center
Driver for Windows Vista (64-bit or 32-bit) and Windows 7 (64-bit or 32-bit), and then download the driver. 

1. Install the Microsoft Windows Device Center Driver as appropriate for your operating system.
2. Windows Vista will automatically configure the driver for you, however Windows 7 requires further configuration.
3. Make sure the Bluetooth device is powered on.
4. Go the Windows 7 control panel and double-click Device Manager (Hardware and Sound > Devices and 

Printers).
5. Bluetooth Peripheral Device(s) will be listed under Other Devices (note this will only be listed if you have 

connected, or tried to connect to, a Bluetooth device previously).

Figure 8 - 1 - Device Manager


Bluetooth Peripheral Devices

You will need to repeat the procedure
listed here for all Bluetooth Peripher-
al Devices listed under Other Devices
i.e. until there are no more Bluetooth
Peripheral Devices listed under this
menu heading.
Bluetooth Connection Problems 8 - 13



Troubleshooting

8

6. Right-click Bluetooth Peripheral Device and click on Update Driver Software.
7. Click Browse my computer for driver software.
8. Click Let Me pick from a list of device drivers on my computer.

Figure 8 - 2 - Browse my computer.../Let me pick from...

9. Select Bluetooth Radios from the list.

Figure 8 - 3 - Select Bluetooth Radios
8 - 14 Bluetooth Connection Problems



Troubleshooting

8

10. A list of drivers will appear with Manufacturer on one side and Model in the other. 
11. Choose Microsoft Corporation (make sure you choose the full name Microsoft Corporation and do not 

choose Microsoft - Note that you must have installed the Microsoft Windows Device Center Driver for 
Microsoft Corporation to appear in the list). 

12. Select Windows Mobile-based device support from the Model list.

Figure 8 - 4 - Select Device Driver

13. Click Next > Yes and the driver will install.
14. Click Close to complete the installation.

Make sure you select
Microsoft Corporation
Bluetooth Connection Problems 8 - 15



Troubleshooting

8

15. The Device Manager should now display the Windows Mobile-based device support under Bluetooth 
Radios.

16. You will need to repeat the process for any other Bluetooth Peripheral Devices listed under Other Devices.

Figure 8 - 5 - Device Manager - Bluetooth Radio
8 - 16 Bluetooth Connection Problems
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

External Monitor (VGA) 
Port

This port allows you to connect an external monitor, or Flat Panel Display, to get dual video or
simultaneous display on the LCD and external monitor/FPD.

e-SATA Port This is a combined e-SATA (external Serial Advanced Technology Attachment)/ USB 2.0
compatible port. Plug external Serial ATA hard drives into this e-SATA (external Serial
Advanced Technology Attachment) port (see page 8 - 12).

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

e-SATA 
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Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

RJ-11 Phone Jack This port connects to the built-in modem if included in your purchase configuration (the modem
and modem port are a factory option). You may plug the telephone line directly into this RJ-11
telephone connection.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

S/PDIF-Out Jack This S/PDIF (Sony/Philips Digital Interface Format) Out Port allows you to connect your DVD-
capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.

Item Description
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USB 2.0/1.1 Ports

USB 3.0 Port
(Factory Option)

These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed
peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as
external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into
the computer, and unplugged from the computer, without the need to turn the system off (if the
power rating of your USB device is 500mA or above, make sure you use the power supply which
comes with the device).

Some models in this series have a single USB 3.0 port on the left side of the computer (Factory
Option), other models will have a USB 2.0 port. The USB 3.0 port is denoted by its blue color;
USB 2.0 ports are colored black. USB 3.0 will transfer data much faster than USB 2.0, and is
backwards-compatible with USB 2.0.

Note that the USB 3.0 port requires a driver installation (see “USB 3.0” on page 4 - 7) and does
not support wake on USB.

Item Description
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Appendix B: Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 20.


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your service center for
the latest details on vid-
eo cards supported.
B - 1
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Video Driver Installation
Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 3.

Insert the Device Drivers & Utilities + User’s Manual disc and click Install Drivers
(button).

Video (VGA)
Model A Computers
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
Model B Computers
1. Click 2.Install VGA Driver > Yes.
2. Click Yes > OK.

NVIDIA Video (VGA)
1. Click 3.Install nVIDIA VGA Driver > Yes.
2. Click Next > Next.
3. Click Finish to restart the computer.
B - 2 Video Driver Installation
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NVIDIA® Optimus™ Technology
Most notebook computers come with either a discrete or integrated graphics solu-
tion.

Discrete graphics solutions feature a dedicated Graphics Processing Unit (GPU)
which are capable of playing games, watching HD video or running GPU-based ap-
plications. However computers with discrete graphics solutions tend to be heavy in
power consumption, and slightly larger in size in order to incorporate the dedicated
discrete GPU.

Integrated graphics solutions usually feature memory sharing technology to help
save power consumption and allow for longer battery life. However computers with
integrated graphics solutions will not usually run games, HD video or GPU-based
applications without severe limitations.

Nvidia® Optimus™ technology is a seamless technology designed to get best per-
formance from the graphics system while allowing longer battery life, without hav-
ing to manually change settings. Thus when an application is run that requires extra
performance or quality, then the system will run the discrete GPU (dGPU); when the
system does not require such enhanced performance it will let the integrated (iGPU)
handle it.


iGPU or dGPU

Note the NVIDIA control
panel refers to High-
performance NVIDIA
processor (which is the
discrete GPU) and Inte-
grated graphics (which
is the integrated GPU).
NVIDIA® Optimus™ Technology B - 3
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How Optimus Technology works
When the system is powered up and is displaying just the desktop, the dGPU will be
powered off. In this case the system is running in the same way as a system without
a discrete graphics solution. However when an application that requires use of the
dGPU is run (e.g, a game or HD Video), the dGPu is powered on and takes over the
processing duties. If the program is closed, then the dGPU will be powered back
down again until required.


Customization 

Options

Although Optimus is
completely seemless to
the user, NVIDIA also
allow customization op-
tions within the control
panel (see “Optimus™
Customization Op-
tions” on page B - 19).
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GPU Button
This computer also features a button  that allows the user to switch between Op-
timus Mode and UMA Mode (Unified Memory Architecture). UMA Mode will use
only the integrated GPU; Optimus Mode will allow the system to automatically de-
termine whether the dGPU or iGPU is used. Thus the user can completely control
how the graphics system operates. Press the GPU button, and the button color will
indicate the current mode.

The GPU LED indicators will display which GPU is currently in use.

Icon Color Description

Green
UMA Mode Activated - The system will use the integrated 

GPU (iGPU) only

Orange
 Optimus Mode Activated - Optimus technology will determine 

when to use the integrated GPU (iGPU) or discrete (dGPU) 
automatically

Icon Color Description

Green Integrated GPU (iGPU) Activated

Orange Discrete GPU (dGPU) Activated

Table B - 1
GPU Button Modes

Table B - 2
GPU LED Indicators
NVIDIA® Optimus™ Technology B - 5
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Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must be installed). DVMT returns whatever memory is no longer needed to the op-
erating system. You can configure the amount of memory to be used by DVMT in
the BIOS (see “Total Graphics Memory (Advanced Menu > Advanced Chipset
Control)” on page 5 - 9).

Note that DVMT is applicable to the integrated GPU only.


DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
B - 6 NVIDIA® Optimus™ Technology
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Intel® Graphics & Media Control Panel
Advanced video configuration options are provided by the Intel® Graphics and
Media Control Panel. To access the control panel:

1. Click Advanced settings in the Screen Resolution control panel in Windows.
2. Click the Intel(R)... tab and click Graphics Properties (button).
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Double-click the Intel(R) G&M control panel in Windows. 

Figure B - 1
Intel® G&M 

Control Panel
Intel® Graphics & Media Control Panel B - 7
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You may make changes to any of the graphics properties by clicking the appropriate
menu tab on the left of the menu and adjusting the settings on the right.

Options & Support

Click Options & Sup-
port and select an item
from the sub-menu to
bring up the help and
support topics.

You will need to be con-
nected to the Internet to
access the key resource
links.

Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure B - 2
Intel® G&M 

Control Panel Tabs
B - 8 Intel® Graphics & Media Control Panel
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Display Devices & Options
Besides the built-in LCD you can also use an external monitor/flat panel display/TV
connected to the external monitor port or to the HDMI-Out port (High-Definition
Multimedia Interface) as your display device. The table below outlines the display
options.

Intel Display Mode Description

Single Display One of the connected displays is used as the display device

Clone Displays
Both connected displays output the same view and may be 
configured independently

Extended Desktop
Both connected displays are treated as separate devices, and 
act as a virtual desktop


Function Key 
Combination

You can use the Fn + F7
key combination to tog-
gle through the display
options:

• Notebook Only
• External Display Only
• Notebook + External 

Display

Make sure you give the
displays enough time to
refresh.

Note that HDMI sup-
ports video and audio
signals.

Table B - 3
Display Modes


Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
G&M control panel to configure the full screen display.
Intel® Graphics & Media Control Panel B - 9
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Attaching Other Displays
If you prefer to use a monitor or flat panel display, connect it to the external monitor
port or HDMI-Out port on the left of the computer.

To Clone Displays:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Clone Displays from the menu. 
4. Click Apply, and OK to confirm the settings change.
5. You can switch the Primary/Secondary Display from the menu.


Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

General Settings

Click General Settings
to access settings the
options for any attached
display. 

Figure B - 3
 Display > Multiple 

Displays (Clone)
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To Enable Extended Desktop:
1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Intel(R) G&M control panel and click Display > Multiple Displays.
3. Click Operating Mode and select Extended Desktop from the menu. 
4. Click Apply, and OK to confirm the settings change.


 Display Settings 

Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure B - 4 

Display > Multiple 

Displays (Extended)

Click the appropriate monitor
icon and drag it to match the
physical arrangement you
wish to use (e.g. the second-
ary display may be extended
left/right/above/below the
primary display).

Click General Settings to
make any adjustments re-
quired.
Attaching Other Displays B - 11
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Configuring an External Display in Windows 7
You can also use the Screen Resolution control panel in Windows 7 to configure an
external display.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Go to the Screen resolution control panel (see “Video Features - Win 7” on

page 1 - 16).
3. Click the Detect button.
4. The computer will then detect any attached displays.


Function Key 
Combination

You can use the Fn +
F7 key combination to
toggle through the dis-
play options:

• Notebook Only
• External Display 

Only
• Notebook + External 

Display

Make sure you give the
displays enough time
to refresh.

Note that HDMI sup-
ports video and audio
signals.

Figure B - 5
Screen Resolution 

Multiple Displays

(Win 7)
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure B - 6 

Screen Resolution 

Multiple Display 

Options

(Win 7)
Configuring an External Display in Windows 7 B - 13
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Using the Windows Logo Key  + P Key Combination to Switch Displays
You can also use the  + P key combination to quickly change display configura-
tion and modes (this is particularly useful when attaching a projector) in Windows 7.

1. Attach your display to the external monitor port or HDMI-Out port, and turn it on.
2. Press the  + P key combination.
3. An on-screen menu will pop up.
4. Use the cursor keys (or  + P) to select the appropriate configuration from the

menu, and press Enter to confirm the selection.

Figure B - 7
 + P Display 

Configuration 

Selection

(Win 7)
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HDMI Audio Configuration
As HDMI (High-Definition Multimedia Interface) carries both audio and video sig-
nals you can configure the audio output as per the instructions below.

Windows Audio Setup for HDMI
1. Connect a device with HDMI support to the HDMI-Out port.
2. Click Start, and click Control Panel (or point to Settings and click Control Panel).
3. Click Sound  (Hardware and Sound).
4. Click Playback (tab), and right-click the attached HDMI supported display device.
5. You can adjust the settings from the menu.

6. Click OK to close the Sound  control panel.

Figure B - 8
Sound Control 

Panel with an HDMI 

Supported Display
HDMI Audio Configuration B - 15
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7. To play audio sources through your external display’s (TV or LCD) speakers you
will need to go to the audio configuration control panel on the display and configure
the audio input accordingly (see your display device manual).

HDMI Notes

• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-
ing to play audio/video sources through the device.

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions on the previous pages.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


Other Applications

If you are using a third
party application to
play DVDs etc. you will
need to consult the ap-
plication’s documenta-
tion to see the
appropriate audio con-
figuration (the applica-
tion must support
digital to analog trans-
lation).
B - 16 HDMI Audio Configuration
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NVIDIA Control Panel
More advanced video configuration options are provided in the NVIDIA Control
Panel tab.

1. Click Start, and click Control Panel (or point to Settings and click Control Panel).
2. Double-click NVIDIA Control Panel (click "Classic View" from the left of the

menu if you are in Control Panel Home).


NVIDIA Control 

Panel 

To access the Ge-
Force..... control panel
from the desktop; right-
click the desktop, then
click NVIDIA Control
Panel.

Figure B - 9
NVIDIA GeForce..... 

Control Panel
NVIDIA Control Panel B - 17
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The NVIDIA Control Panel provides additional video configuration controls and
tools which allow quick access to features such as image settings, 3D Settings and
Video & TV configuration.


Navigating the 
Control Panel

Navigate through the
control panels in much
the same way as you
would a web page.
Click on the sub-head-
ing tasks in the left
menu (and on the high-
lighted links) for infor-
mation. Use the
buttons on the top left
to go back, forward
etc.

Figure B - 10
NVIDIA Control 

Panel
B - 18 NVIDIA Control Panel
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Optimus™ Customization Options
One of the most important aspects of Nvidia® Optimus™ technology is that it will
switch between the integrated GPU and discrete GPU seemlessly and automatically,
and does not require any input from the user. However customization options are of-
fered for users who prefer to set their own parameters for GPU usage.

Context Menu
One of the quickest ways to choose which GPU to use for a particular application is
by using the “Run with graphics processor” in the context menu.

1. Run the NVIDIA Control Panel (see page B - 17).
2. Click View from the top menu and select “Add “Run with graphics processor”

to Context Menu (it should have a tick alongside it).

Figure B - 11
NVIDIA Control 

Panel - View
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3. Close the NVIDIA Control Panel.
4. Make sure the computer is in Optimus Mode (use the GPU Button to switch

modes).
5. Right-click the icon of the application you want to run.
6. Select Run with graphics processor from the context menu.
7. Select either High-performance NVIDIA processor (dGPU) or Integrated

graphics (iGPU) to run the program with the selected GPU.


iGPU or dGPU

Note the NVIDIA con-
trol panel refers to
High-performance
NVIDIA processor
(which is the discrete
GPU) and Integrated
graphics (which is the
integrated GPU).

Figure B - 12
Context Menu with 

Run with graphics 

processor

Right-click the application executable file
B - 20 Optimus™ Customization Options



Video Driver Controls

B

Global Settings
Global settings allows you to set the preferred graphics processor for overall use.
Ideally this would be the iGPU for battery life, but this can also be set to the dGPU
if preferred.

1. Run the NVIDIA Control Panel (see page B - 17).
2. Click Manage 3D Settings (3D Settings) and select Global Settings (tab).
3. Select either Integrated graphics (iGPU) or High performance NVIDIA

Processor (dGPU) from the drop-down menu.
4. Click the Setting menu items to select any options required.

Figure B - 13
Global Settings
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Program Settings
Program settings allows you to make specific adjustments for installed applications.

1. Run the NVIDIA Control Panel (see page B - 17).
2. Click Manage 3D Settings (3D Settings) and select Program Settings (tab).
3. Select a program to customize from the drop-down menu, or click Add to add

any program that does not appear in the menu.
4. Select the preferred graphics processor for the program from the drop-down

menu.
5. Click the Setting menu items to select any options required.

Figure B - 14
Program Settings
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TV Settings
When the TV is enabled as a display device, click the sub-menus under Video &
Television to adjust the video color or image settings.

Figure B - 15
Video & Television 

Settings
TV Settings B - 23
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Appendix C: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your service center for details.
Specifications C - 1
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Processor

Intel® Core™ i7 Mobile Processor:
620M (2.66GHz)
32nm (32 Nanometer) Process 
Technology, 4MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package
===============================

Intel® Core™ i5 Mobile Processor:
540M (2.53GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package

520M (2.4GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package

430M (2.26GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package

Processor (Cont’d)

Intel® Core™ i3 Mobile Processor:
350M (2.26GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package

330M (2.13GHz)
32nm (32 Nanometer) Process 
Technology, 3MB L3 Cache & 1066MHz 
FSB - TDP 35W
rPGA988A Socket P Package

Core Logic

Mobile Intel® HM55 Express Chipset

Display

Model A:
15.6” / 39.62cm 16:9 HD (1366 * 768) / 
HD+ (1600 * 900) / FHD (1920 * 1080) 
TFT LCD

Model B:
17.3” / 43.94cm 16:9 HD+ (1600 * 900) / 
FHD (1920 * 1080) TFT LCD

Memory

Dual Channel DDRIII (DDR3) 
Two 204 Pin SO-DIMM sockets 
supporting DDR3 1066 MHz
Memory Expandable up to 8GB (using 
1GB/2GB/4GB SO-DIMM Modules)

Video

Intel® Integrated GPU and NVIDIA® 
GeForce GT330M Video:

Supports NVIDIA® Optimus 
Technology

Intel® Integrated GPU (Intel® GMA HD):
Intel® GMA HD
DVMT Memory Architecture up to 1.7GB
Microsoft DirectX®10 Compatible
Enhanced Video & 3D Engine
Hardware Acceleration Decoded for
Blu-ray

NVIDIA Discrete GPU (GeForce 
GT330M):
1GB GDDR3 Video RAM
Supports PCIe * 8
Microsoft DirectX®10.1 Compatible
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BIOS

One 32Mb SPI Flash ROM
Phoenix™ BIOS

Storage

One Changeable 12.7mm(h) Super Multi/
Blu-ray Combo Optical Device Drive with 
SATA Interface (Factory Option)

One Changeable 2.5" / 9.5 mm (h) HDD 
with SATA (Serial) Interface

Audio

High Definition Audio Interface
S/PDIF Digital Output
Built-In Microphone
2 * Built-In Speakers

Keyboard, Pointing Device & Buttons

Isolated A4 Size Keyboard
Built-in Touchpad with Multi-Gesture 
Functionality
Three Instant Buttons; WLAN On/Off, 
Mute, Camera On/Off
GPU Mode Button

Interface

Four USB 2.0 Ports
OR
Three USB 2.0 Ports and One (Factory 
Option) USB 3.0 Port

One eSATA Port
One External Monitor Port
One HDMI Out Port
One Headphone-Out Jack
One Microphone-In Jack
One S/PDIF-Out Jack
One RJ-45 LAN Jack
One RJ-11 Modem Jack (Factory Option 
for Model A Computers) 
One DC-In Jack

Card Reader

Embedded 9-in-1 Card Reader 
- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC Compatible
- MS/ MS Pro/ MS Duo

Note: Some of these cards require PC 
adapters that are usually supplied with 
the cards.

Slots

Two Mini-Card Slots with PCIe (Slot 1) & 
USB (Slot 2) interfaces:
Slot 1 for WLAN Module 
Slot 2 for 3.75G Module (Factory Option 
for Model A Computers)

Communication

56K Fax/Modem V.90 & V.92 Compliant 
(Factory Option for Model A 
Computers)

Built-In 10/100/1000Mb Base-TX Ethernet 
LAN

Intel® WiFi Link 6200 (802.11 a/g/n) Half
Mini-Card PCIe WLAN Module 
(Factory Option)

Intel® WiFi Link 6300 (802.11 a/g/n) Half
Mini-Card PCIe WLAN Module 
(Factory Option)

3rd Party WLAN 802.11b/g/n Half Mini-
Card Module with PCIe Interface 
(Factory Option)
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C

Communication (Cont’d)

Bluetooth v2.1 + EDR (Enhanced Data 
Rate) Module (Factory Option)

1.3M Pixel PC Camera Module with USB 
interface

UMTS/HSPDA-based 3.75G Module with 
USB Mini-Card Interface (Factory Option 
for Model A Computers)
Quad-band GSM/GPRS (850 MHz, 900 
MHz, 1800 MHz, 1900 MHz)
UMTS WCDMA FDD (2100 MHz)
Note that UMTS modes CAN NOT be 
used in North America

Power Management

Supports Wake on LAN
Supports Wake on USB (Not Supported 
by the USB 3.0 Port)
Supports Resume from Modem Ring (for 
Model A Computers Only)

Power

Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 4.74A (90 Watts)
Removable 6 Cell Smart Lithium Ion Battery 
Pack 48.84WH
Removable 6 Cell Smart Lithium Ion Battery 
Pack 62.16WH (Factory Option)

Security

Security (Kensington® Type) Lock Slot
BIOS Password
Fingerprint Security (Factory Option for 
Model A Computers)

Operating System

Windows® 7

Design Feature

MOFA II (Magic Of Film Art) Changeable 
LCD Back Covers (Model A Computers 
Only)

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

Model A:
374mm (w) * 250mm (d) * 25 - 37.2mm (h)
2.6 kg with ODD & 48.84WH Battery

Model B:
413mm (w) * 277.5mm (d) * 25.1 - 38.9mm 
(h)
3.1 kg with ODD & 48.84WH Battery
C - 4 Specifications


	Manual
	Preface
	Chapter 1: Quick Start Guide
	Overview
	Advanced Users
	Beginners and Not-So-Advanced Users
	Warning Boxes
	Not Included
	System Startup
	System Software
	Model Differences
	System Map: LCD Panel Open - Model A
	System Map: LCD Panel Open - Model B
	LED Indicators
	Hot Key Buttons & Keyboard
	Keyboard
	Function/Hot Key Indicators
	System Map: Front & Left Views
	System Map: Right & Rear Views
	System Map: Bottom View - Model A
	System Map: Bottom View - Model B
	3.75G/HSPA Module USIM Card Installation
	Video Features
	NVIDIA® Optimus™ Technology
	Power Options
	MOFA LCD Back Covers - Model A

	Chapter 2: Features & Components
	Overview
	Hard Disk Drive
	Optical (CD/DVD) Device
	Loading Discs
	Handling CDs or DVDs
	DVD Regional Codes
	9-in-1 Card Reader
	Touchpad and Buttons/Mouse
	Gestures and Device Settings
	Audio Features
	Optimizing Audio Recording
	Adding a Printer
	USB Printer
	Parallel Printer

	Chapter 3: Power Management
	Overview
	The Power Sources
	AC/DC Adapter
	Battery
	Turning On the Computer
	Power Plans
	Power-Saving States
	Sleep
	Hibernate
	Shut down
	Configuring the Power Buttons
	Resuming Operation
	Energy Star Power Saving
	Battery Information
	Conserving Battery Power
	Battery Life
	New Battery
	Recharging the Battery with the AC/DC Adapter
	Proper handling of the Battery Pack
	Battery FAQ

	Chapter 4: Drivers & Utilities
	What to Install
	Module Driver Installation
	Windows 7 Driver Installation
	Updating/Reinstalling Individual Drivers
	User Account Control
	Windows Security Message
	New Hardware Found
	Driver Installation Procedure
	Chipset
	Video (VGA)
	Video (VGA)
	NVIDIA Video (VGA)
	MEI Driver
	Modem
	LAN
	CardReader
	Touchpad
	Hot Key
	USB 3.0
	Audio
	Windows Experience Index
	Optional Drivers
	PC Camera Module
	Wireless LAN Module
	3.75G/HSPA Module

	Chapter 5: BIOS Utilities
	Overview
	The Power-On Self Test (POST)
	Failing the POST
	Fatal Errors
	Non-Fatal Errors
	The Setup Utility
	Entering Setup
	Setup Screens
	Main Menu
	System Time & Date (Main Menu)
	SATA Port 1/2/3 (Main Menu)
	System/Extended Memory (Main Menu)
	BIOS Revision/KBC/EC Firmware Revision (Main Menu)
	GPU Card/GPU VBIOS Revision/GPU VBIOS Build Date (Main Menu)
	Advanced Menu
	Advanced Chipset Control (Advanced Menu)
	Total Graphics Memory (Advanced Menu > Advanced Chipset Control)
	SATA Mode (Advanced Menu)
	Legacy USB Support: (Advanced Menu)
	Boot-time Diagnostic Screen (Advanced Menu)
	Legacy OS Boot: (Advanced Menu)
	Power on Boot Beep (Advanced Menu)
	Battery Low Alarm Beep (Advanced Menu)
	Security Menu
	Set Supervisor Password (Security Menu)
	Set User Password (Security Menu)
	Password on boot: (Security Menu)
	Boot Menu
	Exit Menu

	Chapter 6: Upgrading The Computer
	Overview
	When Not to Upgrade
	Removing the Battery
	Upgrading the Hard Disk Drive
	Upgrading the Optical (CD/DVD) Device
	Upgrading the System Memory (RAM)
	Changing the Optional LCD Back Covers

	Chapter 7: Modules & Options
	Overview
	Bluetooth Module
	Bluetooth Configuration in Windows 7
	PC Camera Module
	PC Camera Driver Installation
	Wireless LAN Module
	802.11b/g/n Driver Installation
	Intel® Wi-Fi Link Series Driver Installation
	Connecting to a Wireless Network in Windows 7
	3.75G/HSPA Module
	Mobile Partner
	Mobile Partner Application Installation
	Mobile Partner Application
	Profile Management
	Text Messaging Service
	Fingerprint Reader Module
	Fingerprint Reader Driver Installation
	User Enrollment
	Fingerprint Control Center Features

	Chapter 8: Troubleshooting
	Overview
	Basic Hints and Tips
	Backup and General Maintenance
	Viruses
	Upgrading and Adding New Hardware/Software
	Problems and Possible Solutions
	Bluetooth Connection Problems

	Appendix A: Interface (Ports & Jacks)
	Overview
	Notebook Ports and Jacks

	Appendix B: Video Driver Controls
	Video Driver Installation
	Video (VGA)
	Video (VGA)
	NVIDIA Video (VGA)
	NVIDIA® Optimus™ Technology
	Dynamic Video Memory Technology
	Intel® Graphics & Media Control Panel
	Display Devices & Options
	Attaching Other Displays
	Configuring an External Display in Windows 7
	HDMI Audio Configuration
	NVIDIA Control Panel
	Optimus™ Customization Options
	TV Settings

	Appendix C: Specifications
	Processor
	Processor (Cont’d)
	Core Logic
	Display
	Memory
	Video
	BIOS
	Storage
	Audio
	Keyboard, Pointing Device & Buttons
	Interface
	Card Reader
	Slots
	Communication
	Communication (Cont’d)
	Power Management
	Power
	Security
	Operating System
	Design Feature
	Environmental Spec
	Dimensions & Weight



